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Objectives

* Understand the use of spreadsheets and Excel
* Learn the parts of the Excel window

* Scroll through a worksheet and navigate
between worksheets

* Create and save a workbook file
* Enter, analyze, and present quantitative data

* Enter text, numbers, and dates into a
worksheet
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Objectives

* Resize, insert, and remove columns and rows

* Select and move cell ranges

* |Insert formulas and functions

* Insert, delete, move, and rename worksheets
* Work with editing tools

* Format data using patterned text and flash fill
* |Insert and format custom borders

* Preview and print a workbook
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Visual Overview
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The Excel Window
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Introducing Microsoft Excel 2013

 Computer program used to enter, store, analyze,
and present quantitative data in an organized and
easily updatable manner

e Creates electronic versions of spreadsheets
—Collection of text and numbers laid out in a grid
* Displays values calculated from data

e Represents data in both text and graphical from
through the use of charts
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Microsoft Excel 2013 (Continued)

* Allows what-if analysis

—Ability to change values in a spreadsheet and
assess the effect they have on calculated values
automatically

e Automates many tasks through the use of
formulas including both automatic formulas and
custom formulas

* A Quick Analysis tool allowing conversion from
data to charts in two easy steps
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Microsoft Excel 2013 (Continued)

* Integrates data from several spreadsheets within
a single workbook, and also interfaces with other
workbooks when data from multiple sources is
required

 Templates already available for budgets,
calendars, forms, and reports

* A new Flash Fill feature allows you to have data
automatically entered based on initial data you
enter
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Microsoft Excel 2013 (Continued)

e Excel 2013 offers a Chart Recommendation
feature suggesting the best chart to fit your data
needs

e Excel also increased filtering functionality adding
an interactive way to easily filter data in query
tables and Excel data tables

e Excel 2013 adds a One Workbook, One Table
feature allowing you to view multiple workbooks
simultaneously
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Microsoft Excel 2013 (Continued)

e Excel 2013 includes additional functions in several
areas including basic math, trigonometry,
statistics, look-up, and text functions

 New chart features include additions to the chart
ribbon, richer data labeling, and adds animation
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Spreadsheet Data in Excel
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Worksheet Navigation

A workbook can have two kinds of sheets:

—Worksheet contains a grid of rows and
columns into which user enters data

—Chart sheet provides visual representation
of data

* Cell reference identifies column/row location
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Worksheet Navigation

* To navigate between worksheets
—Use sheet tabs
* To navigate within a worksheet

—Use mouse, keyboard, GoTo dialog box, or
type cell reference in Name box

GoTo 7 IEN

cell reference of Reference
the cell you want |3 c:s
to make active
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Worksheet Navigation Keys

Press To move the active cell

T .L —— Up, down, left, or right one cell

Home To column A of the current row

Ctrl+Home To cell A1

Ctrl+End To the last cell in the worksheet that contains data
Enter Down one row or to the start of the next row of data
Shift+Enter Up one row

Tab One column to the right

Shift+Tab One column to the left

PgUp, PgDn Up or down one screen

Ctrl+PgUp, Ctrl+PgDn
© 2014 Cengage Learning

To the previous or next sheet in the workbook
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Planning a Workbook

* Use a planning analysis sheet to define:
—Goal or purpose of workbook
—Type of data to collect

—Formulas needed to apply to data you
collected and entered

—Appearance of workbook content
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Creating a New Work Book

* You create new workbooks from the New
screen in Backstage view from the Blank
workbook template

— On the ribbon, click the File tab to display
Backstage view.

— Click New in the navigation bar to display the New
screen

— Click the Blank workbook tile.
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Working with Worksheets

* |nserting a worksheet

—Name of new worksheet is based on number
and names of other sheets in the workbook

* Deleting a worksheet
 Renaming a worksheet

—31 characters maximum, including blank
spaces

—Width of sheet tab adjusts to length of name
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Working with Worksheets

* Moving and copying a worksheet
—To move:
* Click and drag
—To copy:
* Ctrl + drag and drop

—Place most important worksheets at
beginning of workbook (leftmost sheet
tabs), less important worksheets toward
end (rightmost tabs)
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Entering Text, Numbers, and Dates

* Text data
— Combination of letters, numbers, and symbols
— Often referred to as a text string

 Number data

— Numerical value to be used in a mathematical
calculation

 Date and time data

— Commonly recognized formats for date and time
values
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Entering Text

 New data appears in both the active cell and
the formula bar

* Truncation

* AutoComplete feature

* To enter multiple lines of text within a cell
—Create a line break with Alt + Enter
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Entering Text

Figure 1-12 Documentation sheet
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Entering Numbers
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Editing Cell Content

* As you work, you might find entries you need
to change or correct.

— If you want to replace all of the content in a cell,
you simply select the cell and then type the new
entry to overwrite the previous entry.

— If you need to replace only part of a cell’s content,
you can work in Edit mode.
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Editing Cell Content in Edit Mode

 Edit Mode

— Double-click the cell to select the cell and switch to
Edit mode
A blinking insertion point appears within the text of cell

— Press the arrow keys to move the insertion point
to the right of the word being edited

— Press the Backspace key three times to delete the
word being edited

— Type & to enter the new text, and then press the
Enter key
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Editing Worksheet Content

 Use Edit mode to edit cell contents

— Keyboard shortcuts apply only to text within
selected cell

Figure 1-13 Revised Documentation sheet
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* Undoing and redoing an action

— Excel maintains a list of actions performed in a
workbook during current session
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Editing Worksheet Content

* Number displayed as text

s B
green triangle

warns about a —LP .
9 Postal Coc 03061 --——rq

10 |Phonc
11

potential error
| e A P 4

wm s W N

FILE HOME NSERT PAGE LAYOUT

Calibn

N Format Painter

boarc e Font

A B
Customer Order

Ship To
First Nam« Tobias
Last Name¢ Gregson

Address 412 Apple Grove St.
City Nashua
State NH

(603) 5554128

FORN

1ULAS

¥ = Wrap Text

€3 = Merge & Center ~

y :
postal code is left-
| aligned in the cell

stomer Order = Exce

=
General - It
£ - ’ Condwional F
®

Formattng ~

New Perspectives on Microsoft Office 2013



Entering Numbers

ISBN CATEGOR BINDING TITLE AUTHOR(¢PRICE Qry & ™\
. . numbers are
0-374-253 Used Hardcover Samurai V' Milton, Gi $5.95 2 e
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Working with Columns and Rows

* To make data easier to read:

—Modify size of columns and rows in a
worksheet

* To modify size of columns or rows:
—Drag border to resize
—Double-click border to autofit
—Format the Cells group to specify
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Working with Columns and Rows

e Column width

—Expressed in terms of number of characters
or pixels (8.43 characters equals 64 pixels)

—Note: Pixel size is based on screen
resolution

* Row height

—Measured in points (1/72 of an inch) or
pixels

—Default row height: 15 points or 20 pixels
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Working with Columns and Rows
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Working with Columns and Rows

* Resizing columns and rows with AutoFit

Figure 1-20 Resized columns
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Working with Columns and Rows

* Deleting and clearing a row or column

—Deleting removes both the data and the
cells

—Clearing removes the data, leaving blank
cells where data had been

New Perspectives on Microsoft Office 2013



Wrapping Text Within a Cell

* Wrapping text enables text to display on two
or more rows within one cell allowing more
text within a narrower column.

— Resize the width of column as appropriate.
— Select the cells you wish to apply wrapping to

— On the Home tab, in the Alignment group, click the
Wrap Text button.

* The Wrap Text button is toggled on, and text in the
selected cells that exceeds the column width wraps to a
new line.

New Perspectives on Microsoft Office 2013



Working with Cells and Ranges

* Range reference indicates location and size of
a cell range

—Adjacent (A1:G5)

—Nonadjacent (A1:A5;F1:G5)
* Selecting a range

—Work with all cells in the range as a group
* Moving and copying a range

—Drag and drop

—Cut and paste
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Working with Cells and Ranges

* Inserting and deleting a range

—Existing cells shift to accommodate the

change
Cells being inserted in a worksheet

 selected range
where new cells —————
~ will be inserted )

D ' ’ » ’

i

A ' C T e N\
' { inserted cells
A 3 * { ) £ ~ s

g <Pr-
agzs=3x

EF

and adjacent
cells shifted to

= L r—r—— selected range l
the right

~ selected range A - _ - , . . : . &
where new cells B N g 3 . = inserted cells )

. will be inserted —— : p "
‘ ' 2 s lc oo > 2 , Lo | selected range
% ___Jo6 __fu) 5 : | and adjacent
 cells shifted down
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Moving a cell or a Range of Cells

* Select the cell or range you want to move or

copy
* Move the pointer over the border of the

selection until the pointer changes shape

* To move the range, click the border and drag
the selection to a new location

— Or to copy the range, hold down the Ctrl key and
drag the selection to a new location
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Copying a Cell or Range of Cells

* Select the cell or range you want to move or
copy
* On the Home tab, click the Cut or Copy button

— Or right-click the selection, and then click Cut or
Copy on the shortcut menu

* Select the cell or the upper-left cell of the
range where you want to paste the content

* Click the Paste button
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Visual Overview
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Worksheet Data
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Working with Formulas

* Formula
— An expression that returns a value

— Written using operators that combine different
values, resulting in a single displayed value

Figure 1-22 Arithmetic operators

Arithmetic
Operation Operator Example Description
Addition + =B1+B2+B3 Adds the values in cells B1, BZ, and B3
Subtraction - =C9-B2 Subtracts the value in cell BZ from the value in cell C9
Multiplication * =C9*B9 Multiplies the values in cells C9 and B9
Division / =C9/B9 Divides the value in cell C9 by the value in cell B?
Exponentiation A =B5~3 Raises the value of cell BS to the third power

@ 2014 Cengage Learning
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Working with Formulas

* Entering a formula

—Click cell where you want formula results to
appear

—Type = and an expression that calculates a
value using cell references and arithmetic
operators

* Cell references allow you to change values

used in the calculation without having to
modify the formula itself

—Press Enter or Tab to complete the formula
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Working with Formulas

* Order of precedence

—Set of predefined rules used to determine
sequence in which operators are applied in
a calculation

Figure 1-23 Order of operations applied to Excel formulas

Formula Application of the Order of Operations Result
=50+10%5 10*5 calculated first and then 50 is added 100
=(50+10)*S {50+ 10) calculated first and then 60 is multiplied by 5 300
=50/10-5 50/10 calculated first and then 5 is subtracted 0
=50/(10-5) (10-5) calculated first and then 50 is divided by that value 10
=50/10*5 Two operators at same precedence level, so the calculation 25
is done left to right in the expression
=50/(10*5) (10*5) is calculated first and then 50 is divided by that value 1

© 2014 Cengage Learning
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Working with Formulas

* Viewing a formula

— Select cell and review expression displayed in the
formula bar

— Each cell reference is color coded in the formula
and corresponding cell in the worksheet

Figure 1-24 Formula being entered in a cell

formula displayed ‘
in the formula bar

wp To
Toblas
formula in cell H13 |
multiplies the values
in cells F13 and G13 v

TITLE AUTHOR(S) PRICE Qry CHARGE
Samwral Wiliam: The Englishman RS
w ) e Minen, Gles 55.95 /‘- ¥ {
L2} lobes Fuse, Tomoko 524.95 "
Too Mag Secret Langusge

of Diag Callgragptvy we2a, Lastlo 58

T by Morgan, Gile 53

llllllll

; S
\ : .
1 | cell references
1 | are color coded
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Working with Formulas

* Copying and pasting formulas

—Cell references adjust to reflect new
location of the formula in the worksheet

Figure 1-25 Copied and pasted formula

VIEW
” . ;'!, S B > | n ?:,‘.: '4 Y “
,,,,, R $ ditional F Cell t A Sort & Find &
Foemattin b t Lle filte te
Editing
H
E AUTHOR(S) PRICE Qry CHARGE
urai William: The Englishman
> Opened Japan Milton, Giles $5.95 2 $11.90
al Origami Globes Fuse, Tomoko $24.95 3{__517_4_.%5_: ) e
Magic: The Secret Language formula pasted I
iagrams and Calligraphy Legeza, Laszlo $8.95 1 $8.95 into the
y. \ Holy Grail Morgan, Giles $3.75 1 $3.75 selected cells )
button prOVides more der on the Links Christie, Agatha $7.50 2| $15.00 | i
options for pasting —

_— (Ceel) =
~ formulas and values |
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Working with Formulas

* Guidelines for writing effective formulas:
—Keep them simple
—Do not hide data values within formulas

—Break up formulas to show intermediate
results
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Introducing Functions

* Function
— Named operation that returns a value

— Simplifies a formula, reducing a long formula into a

compact statement; for example, to add values in
the range A1:A10:

* Enter the long formula:
=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10
- or -
* Use the SUM function to accomplish the same
thing:
=SUM(A1:A10)
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Entering Functions with AutoSum

* Fast, convenient way to enter commonly used
functions

* Includes buttons to quickly insert/generate:
— Sum of values in column or row (SUM)
— Average value in column or row (AVERAGE)

— Total count of numeric values in column or row
(COUNT)

— Minimum value in column or row (MIN)

— Maximum value in column or row (MAX)
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Entering Functions with AutoSum

SUM function being entered with the AutoSum button

7 - P Customer Order - Exncel foans R\ ? - 0
E e non s i s S _ AutoSum button arrow | - -
X, Cut 2 AutoSum -
D) Copy ’“
~ Fras
Y . Fom ,/' ™ Nunte Nyt et - tonng ~
LOOKY x =SUM(H13:H17) it formula appearsin v
the formula bar
A 4 C D £ f G H ' J K a
a8 State NH
9 PostalCode 03061
10 Phone {603) 555-4128
n y
cells used in
12 I1SBN CATEGORY BINDING TITLE AUTHOR(S) PRICE  QTY CHARGE the function ;
Samurai William: The Englishman ) | H i
13 0-374-253854 Used Hardcaver Who Opened Japan Milton, Giles $5.95 2: $11.90 E ~ s h'ghhghted/’
14 4.889-96213-1 New Softcover Floral Ongami Globes Fuse, Tomoko 52495 3E $74.85 : I
Tao Magic: The Secret Language } |
15 0-500-27062-7 New Hardcover of Diagrams and Calligraphy Legeza, Laszlo $8.95 1: $8.95 |
16 0-785-82169-4  Used Hardcover The Holy Grail Morgan, Giles $3.75 1: $3.751
17 0-854-56516-7 New Softcover Murder on the Links Christie, Agatha $7.50 2;__5_1_5:_09_'
18| [ Sobrots| -SUM(H13:H17)
19 p ¥ P UM jmember 1, [rumber?] )
20 SUM function adds B N ) \ _
21 the values in the ScreenTip shows the I |‘ range reference )
i selected range ] . syntax of the SUM function | b /
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Previewing a Workbook

* Changing worksheet views
—Normal view
—Page Layout view
—Page Break Preview
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Page Layout View
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Page Break Preview

Workshee T Pae Break Peview

(pagﬂofthe printout) [pageZofthepﬁntout)

Al v \ L Customer Order
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Previewing a Workbook

* Working with page orientation
—Portrait orientation (default)
* Page is taller than wide
—Landscape orientation
* Page is wider than tall
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Printing a Workbook

* Print tab provides options for choosing what
to print and how to print

—Printout includes only the data in the
worksheet

—QOther elements (e.g., row/column headings,
gridlines) will not print by default

* Good practice: Review print preview before
printing to ensure that printout looks exactly
as you intended and avoid unnecessary

—reprintng
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Printing a Workbook

Figure 1-40 Print screen in Backstage view

-
Back button closes
Backstage view
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. preview of |
the printout |
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Viewing and Printing Worksheet
Farmulas

 Switch to formula view

— Useful when you encounter unexpected results
and want to examine underlying formulas or to

discuss your formulas with a colleague
T ' orhcet with formulas displayed

=
18
: = a =
ption to print T
the gridlines
e :
option to print th w
| date displaye. nd column headings
o3 & number
Cusion ".1:_
%‘:"—' ;:, — ]l formulas displayed
|~ — 7 — 1 instead of results
j== o
= xt and numbars
E TR displayed as usual
e Lanwer _— e T e
----- —em
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Viewing and Printing Worksheet
Formulas

* Scaling the printout of a worksheet forces

contents to fit on a single page
Printout scaled to fit on one page

@ d* :
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